
1 Getting Started On
Windows

Welcome to ACME! This guide will help you get set up for ACME.

Installing WSL
Windows Subsystem for Linux (WSL) is a compatibility layer for running Linux natively on Windows
10 and 11. We’ll go through the steps to install Ubuntu on Windows using WSL, which you will use
to run all your code in ACME. You may have already developed your own workflow on Windows
that you’re familiar with, but we highly recommend that you use WSL, as not doing so will most
certainly give you extensive grief when trying to install different items for many ACME labs.
Don’t worry if you have zero Linux experience. Even with very little or no Linux experience, you
will soon become comfortable enough to help your peers and coworkers with it in the future.

1. Enabling WSL:

(a) Open the Start menu and search for “Turn Windows features on or off”.

(b) Click on it.

(c) In the “Windows Features” window, scroll down until you see “Windows Subsystem for
Linux” in the list.

(d) Check the box next to it to enable the feature.

(e) You should also enable “Virtual Machine Platform”.

(f) Click “OK” to save your changes.

2. Installing Ubuntu: Now that WSL is enabled, you can install Ubuntu on your computer.

(a) Open the Microsoft Store app on your computer.

(b) Search for “Ubuntu” in the search bar and select “Ubuntu” from the search results.

(c) Click the “Get” button to download and install Ubuntu on your computer.

(d) Wait for the installation to complete.

3. Launching Ubuntu: Now that Ubuntu is installed, we can launch it and start using it.

(a) Press the Windows key and type “Ubuntu” in the search bar.

(b) Select “Ubuntu” from the search results to launch it.
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2 Lab 1. Getting Started On Windows

(c) Wait for Ubuntu to start up and create a new user account with a username and password
when prompted.

Make sure not to forget your password!

4. Installing Linux Updates:

(a) In the Ubuntu terminal, run the command sudo apt update to update the package list.

(b) Run the command sudo apt upgrade to install any necessary updates.

Finding Your Files in WSL
WSL has its own independent home and file system apart from Windows, but you can still access
your files in Windows from WSL by navigating back through the mnt directory. For example, to
access your c drive (your files) you can use cd /mnt/c to navigate to your standard head directory.
So if you want to access your Desktop, you can find it at /mnt/c/Users/<username>/Desktop. This
may feel counterintuitive to how Windows normally works, but this one difference is a small price to
pay to make your life much easier.

Fortunately, you can actually change the default “boot” directory that Ubuntu starts in. The
process for changing your boot directory is very simple, and it is recommended that you do so to
make your life easier.

1. Open your Ubuntu terminal.

2. Type cd ~ to go to your home directory.

3. Type sudo nano .profile to open your profile file.

4. Add the path of the desired default directory to the end of the file. For example, if you wanted to
change the default “boot” directory to be your base user directory, you would add the following
line of code to the end of the file:

cd /mnt/c/Users/<username>

where <username> is the name of your user.

5. Save and exit the file by pressing Ctrl+X, then Y, and finally Enter.

6. Close your terminal and reopen it.

Ubuntu should now immediately start in your user directory.

Git
Git is a version control system that helps you manage changes to your code over time. This section
will serve as a guide for the later steps, so do not worry about learning everything right now. It will
come with time. Git allows you to keep track of different versions of your code, collaborate with
others, and revert changes if necessary.

To install Git on WSL or another Linux system, run the following command in Ubuntu:

sudo apt install git
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Application in ACME
In ACME, Git is not only used to save and organize your work, but also to turn in assignments.
The most current version of your code will be pulled by the instructor at a predesignated time and
graded. If you always push your code when you’re done working on it, you will never miss turning
in an assignment. Explanations of these Git terms are provided later in this document.

Downloading Course Materials
The lab manuals can be found at https://acme.byu.edu/. You can also download the zip folders
that contain the lab materials from this page. However, you won’t need to download them since the
method we will use to set up your GitHub repository will not require them. There is a more involved
way to set everything up (found in the Additional Materials section), which involves downloading
the zip files and pushing your materials up to a GitHub repository, but the following procedure is
much simpler.

Online Setup
1. Sign up for GitHub. If you already have a GitHub account, sign into your account and proceed

to the next step. Otherwise, create a GitHub account at https://github.com/. This is where
you will store your files online for grading.

2. Set up your Git credentials. You will need to set up your your Git user.name and user.email.
user.name should be your actual name, and user.email must be the email associated with
your GitHub account. To do this, open Ubuntu, and run the following code:

$ git config --global user.name "your name"
$ git config --global user.email "your email"

3. Create an ssh key. This step only needs to be done once on each computer you want to use
to access your repository. If you have multiple repositories on the same computer, you do not
need to repeat this step for each one. To create an ssh key, enter the following command in
Ubuntu:

ssh-keygen -t ecdsa -b 256

Press the Enter or Return key to accept the default file location. It will then prompt you
to enter a Password, but you can press Enter or Return again to skip this step if you don’t
want a Password. The key will then be created. The file for the key will be placed in the
/home/<username>/.ssh (or ~/.ssh) directory.

Now that the key is created, you need to add it to your GitHub account. From GitHub, click
on your profile icon in the upper right corner, and click on Settings towards the bottom of
the menu. Now click on SSH and GPG keys on the left, and click the green New SSH key
button. Make a Title for this key (it doesn’t matter what you put, but you may wish to specify
which machine this key will be used for). Make sure the Key type is set to Authentication
Key.

https://acme.byu.edu/
https://github.com/
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Now, using the file explorer, navigate to the .ssh folder, and open the public key file. This file
should be called id_ecdsa.pub; do NOT use id_ecdsa (without the .pub extension). Copy
the contents of this file and paste it into the Key field on GitHub.

If you’re having trouble navigating to the .ssh folder, you can try to print the contents of the
folder by running this code in your terminal:

cat ~/.ssh/id_ecdsa.pub

Once you’ve pasted the contents of id_ecdsa.pub into GitHub, press the green Add SSH key
button. Then, in your terminal run

ssh-add ~/.ssh/id_ecdsa

If you get an error that says “Could not open a connection to your authentication agent,” then
run

eval $(ssh-agent)
ssh-add ~/.ssh/id_ecdsa

To verify that this worked, you should see your new ssh key in the file ~/.ssh/known_hosts.

4. Clone GitHub Classroom Repository. In this step, you will set up a GitHub repository with all
of your lab materials. The following steps will guide you through the easiest way to accomplish
this, in which you will simply clone a template repository from GitHub Classroom.

Repeat this procedure for both Volume 1 and Volume 2.

• On Learning Suite, you will find a link to a GitHub Classroom. Open the link in a new
tab.

• Click the green Accept this assignment button.

• After a few seconds, refresh the page. The page should now say “You’re ready to go!”
Beneath the line that reads “Your assignment repository has been created:” there should
be a GitHub link. Click the link.

• You will be directed to your personal GitHub repository, which you must now clone onto
your computer. To clone the repository, click on the green Code button. Make sure the
SSH option is selected, then copy the link below it.

• Now, in Ubuntu, navigate to a good location on your computer where you will want all
your lab materials (i.e. Documents, Desktop, etc.), then type git clone followed by a
space and then the link you copied from GitHub. It should look something like

git clone git@github.com:classroom_name/repo_name.git

Then press Enter or Return. An identical clone of the GitHub repository should now
download onto your computer.

5. Download data files. Many labs have accompanying data files. To download these files, navigate
into each of your course directories and run the download_data.sh bash script, which down-
loads the files and places them in the correct lab folders for you. You can also find individual
data files through Student-Materials/wiki/Lab-Index.

https://github.com/Foundations-of-Applied-Mathematics/Student-Materials/wiki/Lab-Index
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# Navigate to your folder and run the script
$ cd /path/to/folder
$ bash download_data.sh

Repeat this process for both Volume 1 and Volume 2.

Using VSCode
VSCode is the recommended code editor in ACME, though it is not required. We recommended it
because it’s free and open source, and it can use WSL very easily. You can download it at https:
//code.visualstudio.com/. Once you have it installed, you can search for it on your machine
under: Visual Studio Code. You can also open it from the terminal by typing code.

1. Installing the Remote WSL Extension: The Remote WSL extension allows you to use VSCode
to edit files in WSL. You can install it by opening VSCode and clicking on the Extensions tab
on the left (little building blocks). Search for WSL. Then click install.

You will need to restart VSCode for the extension to take effect.

2. Opening a Folder in WSL: In order to open a folder in WSL, click on the bottom left corner
of VSCode (blue box) to Open a Remote Window. Then click Connect to WSL. Now click on
the Explorer icon in the upper left (two pages), and click Open Folder. If you see

/home/<username>

in the searchbar, you are accessing the WSL home directory, not the one where your files
are. Type in the complete file path to one of your course directories, such as /mnt/c/Users/<
username>/Desktop/Volume1. Make sure to navigate into the folder that contains all the lab
materials, not just Desktop or another higher directory. Click ok to save this path. Repeat
these steps for the other Volume.

Installing Python
To install Python, navigate into one of your course directories (e.g. Volume1) and run

bash install_python.sh

Now restart your terminal. On Windows or Linux, you will need to run the following commands in
WSL or Standard Linux Terminal:

sudo apt-get install graphviz
sudo apt-get install libopenmpi-dev
sudo apt-get install ffmpeg
sudo apt-get install g++
sudo apt-get install python3-tk
sudo apt-get install openjdk-8-jdk

Assuming no errors, you should now run

https://code.visualstudio.com/
https://code.visualstudio.com/
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bash install_dependencies.sh

You have now installed Python and all necessary dependencies you will need in ACME!

Setup on a Lab Machine
Most ACME students prefer to do their work on their own machines. However, throughout the
semester something may happen where you are unable to install something, or your computer might
break, and it will be easier to use a different computer. For this reason, it is recommended that you
set up your repository on a lab machine as well. The software on the lab machine will always work,
and if it somehow doesn’t, you will have dedicated IT help with the lab computers.

The simplest way to set up a lab machine is to log into one of them in person, but you can
also access one remotely through the Secure Shell Protocol (ssh). If you are unfamiliar with the ssh
process, don’t worry; you will learn this skill and many others shortly in the ACME program. For
now, we will explain some ssh basics (or if you have physical access to a lab machine, you may skip
this paragraph). To ssh onto a lab machine, open Ubuntu and type:

ssh <netID>@acme<number_between_01_and_30>.byu.edu

You will then be prompted for your password; this will be your BYU password. If this doesn’t work,
try another number (it will not matter which number you end up using). When you ssh onto a lab
machine, your terminal gains control of the lab computer. You can verify this by checking that the
machine name before the $ is now different than before and says “acme”.

Now that you have access to a lab machine, you will need to repeat the step Create an ssh key
from the Online Setup section. This will involve uploading another ssh key to GitHub specific to this
lab machine. Next, you will need to clone your repository onto the lab machine. To do this, first
navigate into the myacmeshare folder by running

cd myacmeshare

in your terminal. Then, go to GitHub and navigate to the repository you wish to clone. Find and
click the green Code button. Make sure that SSH is underlined and copy the link; then run

git clone <link>

in your terminal. This will clone your repository onto the lab machine.
You will also need to repeat the step Download data files from the Online Setup section. Once

you have repeated this process for both volumes, you are ready to go. You can now access your
repository on the lab machine. Now, if anything goes wrong, you can either ssh onto the lab machine
or use it in person, and you will be able to access and work on your ACME labs without a problem.

You can also use VSCode to ssh onto the lab machine in a similar way to connecting to WSL.
To do this, install the Remote-SSH extension using the Extensions tab on the left (little building
blocks) of the window in VSCode. Then, you can add a Remote Window by clicking on the blue
Open a Remote Window button in the bottom left corner, selecting Connect To Host, and typing in
<netID>@acme<number_between_01_and_30>.byu.edu.
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If All Else Fails. . .

If, while working on a lab, you can’t get something to work on both your own computer and the
lab machine, your last resort is Google Colab. It should be reserved as a last resort, because Google
Colab is formatted in a notebook style, which is fundamentally different than a .py file. However, if
you are ever stuck, keep in mind that it’s still an option. See the Using Google Colab guide in the
Appendix for more information on using Colab for ACME labs.

Additional Git Help
Here are some key concepts and terminology you’ll need to understand and use Git effectively. You
may need to refer back to this multiple times.

• Repositories. A Git repository is a collection of files and folders that Git is tracking. By
creating a repository, you are simply telling the software that it should back up certain files
that you tell it to. When you create a repository, Git creates a hidden directory called .git
inside your project folder that tells it to track those files.

• Adding Files. Git will only track the files that you specifically add. You can add files indi-
vidually, or you can add all the files in a folder at once. To add a file, you’ll typically use the
command:

git add <filename>

• Commits. A commit is a snapshot of your code at a specific point in time. When you make
changes to your code, you can create a new commit to record those changes. Each commit has
a unique identifier, which allows you to reference it later if you need to revert your code to a
previous state. If you are collaborating with others, it gives you an “undo” button specific to
each user, allowing you to be more organized. It is good practice to commit every time you
leave your computer to keep track of your work.

To create a commit, you’ll typically use the command:

git commit -m "Commit message"

• Branches. A branch is a separate line of development that diverges from the main line of
development. By creating a new branch, you can work on a feature or bug fix without affecting
the main codebase. Once you’re done with your changes, you can merge the branch back into
the main codebase.

You probably won’t branch your code off the main branch in the ACME courses, but this term
is still useful to know.

• Cloning. Cloning a repository is simply downloading a codebase. Just like downloading a zip
folder, all the files are present, but the original author does not have access to your files unless
you push them back.

To clone a repository, you’ll typically use the command:

git clone <url>
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• Pushing and Pulling. Among the most frequent operations you’ll use with Git are pushing and
pulling.

When you push changes to a remote repository, you’re sending your commits to a central server
where others can access them. This will be where the grader accesses your code in order to
give you a grade. To push your changes, you’ll typically use the command:

git push <remote> <branch>

Here, “remote” refers to the remote repository where you want to push your changes (e.g.,
“origin”), and “branch” refers to the name of the branch you’re pushing (e.g., “main”). Good
practice is to push every few hours of working, and absolutely every time you’re done with a
lab. Pushing saves your work on a secure server, meaning if something catastrophic happens
to your computer, none of your work will be lost and you can continue where you left off on a
different machine. Do not assume you’re different and that computer issues will never happen
to you. Doing a lab from scratch twice in a week is guaranteed to take more time than just
once!

Online Repository

Computer

git push origin main git pull origin main

Exchanging Git commits between the repository and a local clone.

When you pull changes from a remote repository, you’re downloading changes that others have
made and incorporating them into your local codebase. This will be used to pull your grading
feedback back from the grader. To pull changes, you’ll typically use the command:

git pull <remote> <branch>

Here, “remote” and “branch” have the same meanings as in the git push command. Good
practice is to pull just before any time you push.

• Origin and Main. “Origin” and “main” are two terms you’ll often see when working with Git.

“Origin” refers to the default remote repository where your code is stored. When you clone a
repository, Git sets up a remote called “origin” that points to the URL of the original repository.
You can push/pull changes to/from “origin” to collaborate with others.

“Main” is the name of the default branch in a Git repository. This is the branch where the
main line of development occurs, and it’s typically the branch you’ll be working on most of the
time. However, depending on the repository, the default branch may be named something else
(e.g., “master”).
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Command Explanation
git status Display the staging area and untracked changes.
git pull origin main Pull changes from the online repository.
git push origin main Push changes to the online repository.
git add <filename(s)> Add a file or files to the staging area.
git add -u Add all modified, tracked files to the staging area.
git commit -m "<message>" Save the changes in the staging area with a given message.
git checkout -- <filename> Revert changes to an unstaged file since the last commit.
git reset HEAD -- <filename> Remove a file from the staging area.
git diff <filename> See the changes to an unstaged file since the last commit.
git diff --cached <filename> See the changes to a staged file since the last commit.
git config --local <option> Record your credentials (user.name, user.email, etc.).

Common Git commands.

Now that you’ve learned about some of Git’s features, it’s time to implement them in your first
ACME Lab, Intro to GitHub!
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Additional Material

Manual GitHub Setup

Downloading Course Materials
The lab manuals can be found at https://acme.byu.edu/. If you are a Junior, you should also
download the Volume 1 and 2 zip folders. You should then unzip these in a folder you are familiar
with, such as your Documents or Desktop folder.

Achtung!

Make absolutely sure your unzipped lab folders are not nested! When you open each lab folder,
you should NOT have to open another folder to access all the lab materials! If your folder is
nested, move the inner folder out so that there’s only “one layer” to access your lab materials.

Online Setup With Lab Folders
1. Sign up for GitHub. If you already have a GitHub account, sign into your account and proceed

to the next step. Otherwise, create a GitHub account at https://github.com/. This is where
you will store your files online for grading.

2. Create an ssh key. This step only needs to be done once on each computer you want to use
to access your repository. If you have multiple repositories on the same computer, you do not
need to repeat this step for each one. To create an ssh key, enter the following command in
Ubuntu:

ssh-keygen -t ecdsa -b 256

Press the Enter or Return key to accept the default file location. It will then prompt you
to enter a Password, but you can press Enter or Return again to skip this step if you don’t
want a Password. The key will then be created. The file for the key will be placed in the
/home/<username>/.ssh (or ~/.ssh) directory.

Now that the key is created, you need to add it to your GitHub account. From GitHub, click
on your profile icon in the upper right corner, and click on Settings towards the bottom of
the menu. Now click on SSH and GPG keys on the left, and click the green New SSH key
button. Make a Title for this key (it doesn’t matter what you put, but you may wish to specify
which machine this key will be used for). Make sure the Key type is set to Authentication
Key.

Now, using the file explorer, navigate to the .ssh folder, and open the public key file. This file
should be called id_ecdsa.pub; do NOT use id_ecdsa (without the .pub extension). Copy
the contents of this file and paste it into the Key field on GitHub.

If you’re having trouble navigating to the .ssh folder, you can try to print the contents of the
folder by running this code in your terminal:

cat ~/.ssh/id_ecdsa.pub

https://acme.byu.edu/
https://github.com/
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Once you’ve pasted the contents of id_ecdsa.pub into GitHub, press the green Add SSH key
button. Then, in your terminal run

ssh-add ~/.ssh/id_ecdsa

If you get an error that says “Could not open a connection to your authentication agent,” then
run

eval $(ssh-agent)
ssh-add ~/.ssh/id_ecdsa

To verify that this worked, you should see your new ssh key in the file ~/.ssh/known_hosts.

3. Make a new repository. You will need to create a new repository for both Volume 1 and Volume
2. Note: you must follow these instructions exactly. If you do not complete each step exactly
as specified below, delete the repository and start over.

• On your GitHub Home page, click the green Create repository button to the upper left
of the screen; or, if you have already used GitHub before and already have repositories set
up, click on the green New button next to Top Repositories.

• First you will need to provide a Repository name; this can be anything you want, but
please make it relevant to the ACME Volume it will represent; you may also provide a
repository description if you like.

• Mark the repository as Private.

• Leave the box next to Add a README file unchecked (if you accidentally include a
README, delete the repository and start over).

• Under Add .gitignore, select None for .gitignore template (if you accidentally in-
clude a .gitignore, delete the repository and start over).

• Under Choose a license, select None for License.

• Finally, click the green Create repository button.

Repeat this process for both Volume 1 and Volume 2.

4. Give the instructor access to your repository (First Day of Class). If you are doing this before
the first day of class, skip to the next step. In your newly created repository, click the Settings
tab along the top of the page and click on Collaborators on the left. Then click on the green
Add people button. Type your instructor’s GitHub username, select them, then click the big
green Add <username> to this repository button.

5. Connect your folder to the new repository. In Ubuntu enter the following commands.

# Navigate to your folder.
$ cd /path/to/folder # cd means 'change directory'.

# Make sure you are in the right place.
$ pwd # pwd means 'print working directory'.
/path/to/folder
$ ls *.md # ls means 'list files'.
README.md # This means README.md is in the working directory.
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# Connect this folder to the online repository.
$ git init
$ git remote add origin git@github.com:<username>/<repo>.git
# Make sure the link has this form. If it starts with https, select the ←↩

ssh option on GitHub instead.

# Record your credentials. user.name should be your name, and user.email ←↩
must be the email associated with your GitHub account.

$ git config --global user.name "your name"
$ git config --global user.email "your email"

# Update branch name.
$ git branch -M main

# Add the contents of this folder to Git and update the repository.
$ git add --all
$ git commit -m "initial commit"
$ git push origin main

For example, if your GitHub username is greek314, the repository is called acmev1, and the
folder is called Student-Materials/ and is located in Desktop, you would enter the following
commands:

# Navigate to the folder.
$ cd ~/Desktop/Student-Materials

# Make sure this is the right place.
$ pwd
/Users/Archimedes/Desktop/Student-Materials
$ ls *.md
README.md

$ git init
$ git remote add origin git@github.com:greek314/acmev1.git

$ git config --global user.name "archimedes"
$ git config --global user.email "greek314@example.com"

$ git branch -M main

$ git add --all
$ git commit -m "initial commit"
$ git push origin main

At this point you should be able to see the same files on your GitHub repository that are also
found on your machine in your course directory. If you enter the repository URL incorrectly in
the git remote add origin step, you can reset it with the following line:
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$ git remote set-url origin git@github.com:<username>/<repo>.git

Note

You may get an error like the following when you run git push:

...
fatal: Authentication failed for 'https://github.com/<username>/<repo←↩

>.git/'

If this error occurs, your repository URL is in the wrong format; most likely, you used
the https format instead of the ssh format shown above. You can use the git remote
set-url origin command to fix this issue as well.

6. Download data files. Many labs have accompanying data files. To download these files, navigate
into each of your course directories and run the download_data.sh bash script, which down-
loads the files and places them in the correct lab folders for you. You can also find individual
data files through Student-Materials/wiki/Lab-Index.

# Navigate to your folder and run the script
$ cd /path/to/folder
$ bash download_data.sh

Repeat this process for both Volume 1 and Volume 2.

https://github.com/Foundations-of-Applied-Mathematics/Student-Materials/wiki/Lab-Index
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A Using Google Colab

Lab Objective: Google Colab is an environment similar to Jupyter Notebooks that is run remotely
on Google’s servers. It has some advantages over other environments, including easy package man-
agement and installation and the ability to run on a machine that doesn’t have python installed. This
appendix details how Colab can be used for ACME labs, as well as some issues to be aware of and
relevant workarounds.

Setup
Google Colab can be started by going to the Colab website https://colab.research.google.com/
or by opening a .ipynb file from your Google Drive. When Colab starts, you can upload a .ipynb
file by selecting the Upload tab and choosing the .ipynb file you wish to upload. Colab can also be
used with .py files, but the process is somewhat more involved and is detailed below.

Once your file is open in Colab, it can be run and edited like a normal Jupyter notebook.
To submit your lab for grading, you will need to download the file by selecting File > Download
and then either Download .ipynb or Download .py. You will then need to move your file into the
repository clone on your machine in the correct lab folder, where you can then add, commit, and
push it like normal.

Achtung!

Remember to keep the name of the file IDENTICAL to the original name of the lab spec!
Failure to do this will cause the test driver to skip over your file and give you an automatic
zero for the lab!

Using .py Files with Colab

Google Colab only works with .ipynb files, but many ACME labs use .py files. Since the former
filetype has additional formatting, there isn’t a way to directly import a .py file into Colab. The
simplest way around this is to create a new file in Colab and copy-paste the lab file’s contents into
it. This way, it can be edited and used as a normal Jupyter notebook. Then, when you’re finished,
download the notebook as a .py file instead of a .ipynb file.

15
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However, under these circumstances some care must be taken in order for your work to be
graded properly. In particular, before you download your file, make sure that the following are
satisfied:

• All Colab-specific code to upload files is commented out; as the packages used do not exist
outside of Google Colab, the test driver will raise an error when it attempts to import them.

• There are no calls to the lab’s functions, for testing purposes or otherwise, outside of a typical
if __name__=="__main__" statement; otherwise, they will be run when the file is imported by
the test driver, which will certainly cause issues.

Using Data Files
To use a data file in Colab, you must first upload it by running the following in a code cell in Colab:

from google.colab import files
files.upload()

When run, this will create a prompt for you to upload your files. After doing so, the data files can
be accessed from the notebook as normal.

The best way to upload an entire folder is to first zip it, then upload the zipped folder to Colab,
and then unzip it in the Colab notebook:

# To upload a folder called 'data', first zip it, and then upload 'data.zip'
files.upload()
# Then, it can be unzipped
!unzip data.zip

If the files do not need to be in the same folder, you can always simply upload multiple files at once
with the usual files.upload() code.

Installing Packages
One advantage of Google Colab is that a very large percentage of the python packages used in the
ACME labs are already pre-installed. However, there are a few packages that are not installed, and
must be installed each session. Packages can be installed by running pip in a code cell, which is done
by putting an exclamation point before the usual command. For example, to install the GeoPandas
package, you would run:

!pip install geopandas
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